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STORYTELLING-PowerPoint-Windows Movie Maker 2

By: Judy Honaker-Instructional Technology Resource Teacher

Introduction
This tutorial is designed as a basic introduction to Windows Movie Maker 2 (MM2). Movie Maker 2 is
a free program that comes with Windows XP.

This tutorial will provide students with a guide for completing storytelling projects using PowerPoint
and Movie Maker 2.

This tutorial will also provide teachers with a guide for using PowerPoint and Video Clips to create
SOL videos for classroom use.

Students should have already created a PowerPoint following teacher guidelines for
Storytelling Projects

OR

Teachers can use the ADVANCED SEARCH option of Google to find an appropriate
PowerPoint that is NOT copyrighted.

Using the Advanced Search Option in Google.

Get on the Internet
Type the Google URL

‘ 0 () e“' http://www.google.com
8 Click on the Advanced Search tab

Advanced Search
Preferenoes
Google Search | I'mFeeling Lucky | Language Tools

N
. with all of the words {
Find results

with the exact phrase

with at least one of the words |

without the words I

Language Return pages written in English
File Format IDnIg-r 'I return results of the file format E Microsoft Powerpoint (.ppt) :

By using the Advanced Search option and the settings shown above, your Internet
search will only retrieve PowerPoint presentations concerning Ecosystems.
And you will get 100 results on one page, so you won’t have to click Next.

Download and Save the PowerPoint in a folder on your Computer Desktop
Suggestion: Name the Folder something like “Digital Storytelling”

Getting Ready

STEP A: Create a folder on your desktop.
Create a folder on the desktop of each computer



http://www.google.com/
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students will be using for the purpose of storing
all of their pictures, video, audio/music, etc.

1-Close all open files so you can see the desktop.
2-Point your mouse to any open space on desktop
3- Right Click

4-A pop-up menu will appear.

5-Select New—>Folder

6—Click in the little rectangle and rename the
folder by typing Digital Storytelling.

&rrange loons By L]
Refresh

Undo Drelebe Ctrl+Z

Save Az Schams.. .

Graphics Optiors L]

Display Modes ]

Fropertes i Shortat

STEP B:

SAVE everything you plan to use for the project
into this folder. (Digital photos, PowerPoint
presentations, music, voice narrations, etc.

(This is very important-MM2 only records files as
shortcuts, so anything that is moved after you
start your project will lose its shortcut and you
will see ared X.)

Rename the folder and move everything to this
folder.

Ed

Digital
Storyteling

Always save everything in this folder, and
SAVE OFTEN!

SAVING POWERPOINT PRESENTATIONS AS IMAGES (Pictures)

STEP C:

You will need to open the PowerPoint, so the slides can be saved as images.

Saving PowerPoint Slides As JPGS
(images)

You can save any PowerPoint presentation or
slide as an image, so you can import them into
Movie Maker.

Click on File>Save As

Select the drop-down arrow in the Save as type:
Scroll down to JPEG File Interchange Format (*.jpg).
Select Save.

To save the entire PowerPoint file as JPGS, select
Every Slide.

Microsofl Office PowerPoint

-
‘]\'f) Do you want b saxport every shde in the presentation or onfy the current shde?

[ e | [ commsmony | [ cea |

A" Thelide vou bave
1 selected will be
waved 55 8 JPG,

Al shides in ibe
PowerPeint will be

saved as JPGS.

Save A1 ﬁlgl
[T, o) DégAsl Margteling v @ X Sy I - Tosk-

= s bali Prg &t
f} '.!'l FLTIEToE T 8 T
Fy Eacer

Save as type =
JPEG File
Interchange
Foarmar (*.jpg)

By ts Pra et

B | Presentation [*.pot)
Dermgn Template {* gol)
Pt Perl Thow (* ppd)
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PowerPoint will automatically create a folder and Micresoft Office PowerPoint
save the JPGS inside it. Click OK.

i Each shda in your presentation has boen sived a5 o separate file in the folder C! 'meﬂsmd
ecEds\ Summer 2006\ degk sstorytelingMS Drevised

. Settings|ube. knngron|My Documerts| T
The new folder will have the same name

as the PowerPoint.

Inside the folder there will be JPGS of each slide
in the PowerPoint.

il
I
1
I
i

You can import each of these slides (JPGS) as
pictures into MM2.

Before you start check

Make sure your computer has the updated version
of MM2.

To locate MM2, Click on:

Start->Programs—>Accessories>Movie Maker
(may also be located in the Entertainment folder)

Microsoft @ Yindows @ Movie Maker

Version 5.1 (Bulid 2600pap2_gdr (40517-1325 : Servica Pack 1)

. Copyright ® 13812007
If you do not have the updated version, you'll need wmummmw—‘ 4_

to download and install SP2 Windows Update.
Thits product is beensed under the terms of the End-Lser
Licenss Agreement 10

Now you should be ready to start your project.

STEP 1:
Open MM2 Start->Programs->Accessories->Movie Maker
I el [Fer— rpe——
To apen the program: It [ i _' o ——
I. Starr a e f iy
[ | L et
2 AllP Gooowr  [Eon R
A FOgraing YRR |t :
3. Select Windows Movie Maker @ o S | 3
eI
i ;
5 S e

L= ]

a

B
/m"’ -

g =mis mamin s
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SETTING THE TIME ALLOWANCE FOR EACH PICTURE

MM2 has a default setting of 5 seconds per photo. | General | Advanced
You can increase or decrease this setting by:
Clicking on:

Default durations

A default duration will be assigned to each picture or transition when
t is added to the storyboard or tmeline,

Tools->Options->Advanced /
Change the number located to the right of “picture Picture duration: 10 seconds

4% 4)

duration” to the number of desired seconds. Trarsition duration: | 1L.25 gecords %
IMPORTING

STEP 3: 1. Capture Video "~

Click on: “Import Pictures” which is located ) _

under the Capture Video heading. Capture from video device

Import video

Import pictuces
STEP 4: |"|'|:}",'f'r-a._ll:§ ;'."‘h..*;:

1- Locate the file folder that you saved to

your desktop. This should be labeled
“Digital Storytelling.”

2- Double click on the Digital Storytelling Look in: | [} Deskiop
folder.

3- Select the photos that you wish to import, p My Documents
and then click the “Import” button. L6 8 My Computer

4- If you have more than 1 photo to import, My Recent '_"JJ’”'""”E‘""'“”‘ Places
hold down the shift key on the keyboard i
and click on the first photo. Keep holding F

-

down the shift key and click on the last
photo you wish to import. This will import
multiple photos or video clips at once.

WINDOWS MOVIE MAKER INTEFACE

TASKS WINDOW COLLECTIONS WINDOW MONITOR/PLAY BACK WINDOW
LW_ nu:
b - Qe cotene e - =

Collections Plawyer Windosw

STORYBOARD / TIMELINE
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STEP 5:

PLACING IMAGES ONTO THE STORYBOARD/ TIMELINE

Click and Drag the photos or music files from the Collections Pane onto the

Storyboard/Timeline

Collecton Collectons

1. Capture Video -

Crag » oo o oo € on B eorpboard bekos

m‘:‘

ppppp LR T

STEP 6:

SAVE---SAVE---SAVE---SAVE

You can save your MM2 as a project, so
you can edit or add to it at a later time.

B et vew Took O Play  Heb
1 Mew Projoct

¥
L3

L

*

it

Sovve Progect

Gﬂct e File.,

Caphurg Vided,..

Imgart inta Coliechons.

STEP 7:

NARRATION

Narration

MM2 provides for recording and inserting
audio into the timeline. This process of
narration can be accomplished by:

1-- Microphones are built into most
computers (laptops). External microphones
can be used. Note: The microphone should
be inserted into the pink microphone plug on
the CPU.

2-- To narrate, either select the Tools menu
and then Narrate Timeline or select the
microphone icon at the top left of the timeline.
3-- From the Narrate Timeline window, select
Start Narration and the program will begin
recording. To stop the process simply select
Stop Narration.

Note: The green bar on the input level should

» | 1 show Storyboard

[po0o

0:00:10.00

0:00:20

[Narrate Timeline |

Yideo
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go up and down when you speak if the
microphone is operating correctly. If the
green bar does not move when you speak,
you may need to use an external microphone.

4-- Once stopped, you will be directed to save
your narration. Give your narration a specific
name, so you can remember which narration
goes with which video clip, and select save.
5-- On the Narrate Timeline window, select
Done and the audio will be automatically
inserted into the Audio/Music track on the
timeline. As with video, title, and photograph
elements, your created narration can also be
moved or edited within the timeline.

6-- Click Play on the Monitor and sample your
narration. If you don't like it, just delete it, and
re-record.

Narrate Timeline

Dirag the playback indicator on the timeline to
Steps: Inpuk level

L. l Stark Narratinn[:

2. ! L.

Done Mi h
Show more options cakrahole

STEP 8:

EXTENDING TIME/ DURATION OF IMAGES

Step 1: Toggle to the Timeline window.
Step 2: Select the image, video, audio or
music clip that you desire to manipulate.
Step 3: Place the arrowhead over the right
end of the clip and a double red
arrowhead will appear. You can click and
drag to trim the clip. Extending the
picture, video, etc. will give you additional
time for audio/music files.

B 2| ® & | (| T show Storyboard

Hll:ll:l 000000 00072000 00073000 1]

i Click and drag to trim the dip]
AudioMusic
Title Overlay

After you record your narration or add
your music. You can click on the
image/video in the top window and drag
the blue line until the video and audio
have the same ending point.

A 2| & S| @ (» | E show storyboard

Video

Duration: 0:00:09,.33

AudioMusic

Title Overlay
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STEP 9:
TRANSITIONS BETWEEN PICTURES

Transitions - X r4EELD o oyre =m g
MM2 offerg Sixty d|ff'e'rent wdeq tran5|t|pns. o<y 1= :
When applied, transitions provide a unique . el B Sl T
way to smooth the exchange between clips EE OB = . - = = e ae
in your project. '

vourpro pusan BELO=
To insert a transition follow these steps: "Bl T 8 Baa e
1-- From the Movie Tasks pane, under Edit O e s ' JE—
Movie, select View video transitions. - == “ - - B BIDE]

2-- Choose the desired transition, select and
drag into storyboard between desired clips
3-- After inserting transition, preview the
change in the Monitor to determine if it

looks the way you desire.

4-- To change a transition you can either
Undo the action, right click on the transition in
the Storyboard and select delete, or simply
drag a new transition over the old transition.

STEP 10:

ADDING TITLE SLIDES AND CREDIT SLIDES

Titles & credits

To add titles or credits to your movie or slide
show MM2 provides a number of font and
animation options.

To add text, perform the following steps:

1-- From the Movie Tasks pane, under Edit
Movie, select Make titles or credits.

2-- Determine where you want to add a title
and select that option

3-- In the text box which appears, enter your
desired text.

4-- At the bottom of the text box, MM2
provides options for changing text font style,
size, and color Text animation can also be
manipulated through clicking on Change the
title animation and selecting the desired
options

5-- As text additions are made, a sample of
the changes can be seen in the Monitor.
When completed, select Done, add title to
movie and the text will be added to the
timeline.

Where do you want to add a title?

[% Add [Rle at the beginning of the movie.

Add Rle before the selected cho in the timeline,
Add title on the selected clip in the timelne.
Add title after the selacted dip in the timeline.

Add redks at the end of the movie,

J

Salect Tite Fost and Color

ek, Do b o e by ot e

s@lectto change title font and color

Cancel

: lcmmmmmmuu '

— into movie

click to toggle between
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STEP 11:

SAVING YOU VIDEO

Save

Once you have completed your project,
select desktop and save to the folder you
created on the desktop, or save to CD, etc.
1-- From the Movie Tasks pane, under Finish
Movie, select Save to my computer

2-- In the Save Movie File window,

under 1., enter a name for your completed
movie, and

under 2., select the destination that the file
will be saved. (Click on Browse and make
sure you choose the folder created on your
desktop as the destination for your movie to
save.

| recommend leaving the file options setting
as itis.

Changing the file options will change the size
of the movie file.

Note: Some DVD burning software will not
support the WMV file format. If that is the
case, you will need to save your project as
an AV file.

3. Finish Movie

Save ko my compypter
Saveto CD

|\'f:|

cendin e-mail  |58¥ES vour mavis ko your computer as a video file, |

Send bo the Web
Sendko DY camera

Sawe Movie Wizard

Saved Morie File

Erie infoamnadion i o aasad moea e

1Iﬂ'i:=rafiemrrtﬁuryu|.rsweu novie. Hame ?aur ma“ie
iSchonlMia v

@, Chnnse 3 ace bo s v o,
-l

X

Select place to save movie,

b Broyess, .




